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Purchase Request Form Alert
July 2020 Acquisitions

NERS Enhancement (ID #5685)
When a patron in Primo enters an ISBN or EISBN number in a blank Purchase Request form, an alert now displays
indicating whether a holdings for the resource exists in the library. Primo displays a message that a holdings does not exist
for the identifier placed by the patron, which may be because the resource does not exist, because there is a location,
bibliographic record, or holdings that is suppressed from discovery, or because, for electronic resources, the electronic
portfolio is not active. This is also relevant for network and multi-campus.

This functionality is controlled by the customer parameter PR_indicate_for_primo_if_ISBN_exists, and is enabled by
default. See Configuring Other Settings (Acquisitions).

This enhancement is available for Primo classic only and will be made available for PrimoVE users in a future release

See Creating a Purchase Request.

Activating GOBI Real Time Orders Sent from the Relevant Portfolio in the
Community Zone
July 2020 Acquisitions

Idea Exchange SF: 00596978 00713525 00426146
For orders originating from GOBI, Alma will attempt to locate the relevant portfolio located within a Community Zone
collection using the vendor proprietary identifier number or the ISBN/ISSN and activate it within the relevant collection in the
institution, for this functionality to work it is important that the relevant collection will be activated from the Community Zone
in the institution. In cases where Alma does not find a matching portfolio in the relevant Community Zone collection or if the
relevant collection was not activated in the institution, a stand-alone portfolio will be created in Alma will not be linked to
a Community Zone portfolio. See GOBI vendors list for list of Community Zone collections which supports this functionality.

Additionally, three new collections are now available in the OASIS vendors list.

Move Invoice Owner from an Institution to a Library
July 2020 Acquisitions

Idea Exchange SF: 00810848
You can now change the owner for an invoice after it is edited. The values for the Owner list depend on the owner of the
linked PO line/s, user role scope, library availability for vendor, and vendor account and funds. When saving the invoice, if

Ex Libris, Part of Clarivate 1

https://knowledge.exlibrisgroup.com/
https://knowledge.exlibrisgroup.com/
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/020Acquisitions/040Configuring_Acquisitions/200Configuring_Other_Settings


the invoice owner is the institution but all the PO lines associated with the invoice lines are owned by a single library, a
confirmation message displays that allows you to confirm or cancel your changes.

Watch the Move Invoice from the Institution to a Library video (1:20 minutes).

Platform Field Added to the SUSHI Account Details
July 2020 Acquisitions

Idea Exchange SF: 00799252 00800227 00801116 00802185 00802271 00807054 00810911 00814981 00818471
00831882
When configuring a SUSHI account for COUNTER 5, The SUSHI Account Details page now includes a Platform field. This
field should be populated for vendors that require a platform code for successful harvesting of usage data. Note that the
platform code is case sensitive. Only one platform code can be used per SUSHI account.

See Managing SUSHI Accounts.

Advanced Search for Users
July 2020 Administration and Infrastructure

Idea Exchange SF: 00180020 00214711 00220450 00226302 00024637 00024650 00074581 00084395 00102382
00125857 00126248 00129769
You can now search for users by combining search criteria, using Alma advanced search. This is available only to users
with the roles and privileges to search for users.

In addition, there are new search options for user records. The new search options in advanced search are:

• User group - Equals, Is Empty, Not Equals, Is Not Empty - equals and not equals options display a multiple choice
drop-down list.

• Create date - Equals, Before, After

• Birth date - Equals, Before, After, Is Empty

• Expiration date - Equals, Before, After, Is Empty

• Purge date - Equals, Before, After, Is Empty

• Last activity date - Equals, Before, After, Is Empty

• Statistical category - Equals, Is Empty, Not Equals, Is Not Empty - equals and not equals options display a multiple
choice drop-down list.

• Note - Contains Keywords, Contains Phrase - this option is also available on the simple search

• Has note type - Equals, Not equals - displays a multiple choice drop-down list.

• Has block type - Equals, Not Equals - displays a multiple choice drop-down list with block types.

The quick autocomplete search in the Patron Services Workbench currently uses the ‘All’ search, including the new
indexes. In the upcoming Release Update, this will be changed so that the search will be limited to names, emails and
identifiers.

Note
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• Has Identifier type - Equals, Not equals - displays a multiple choice drop-down list.

• Fine/fee total sum - <, <=, >, >=

• Campus - Equals, Is Empty, Not Equals, Is Not Empty - equals and not equals options display a multiple choice drop-
down list.

New options for existing search criteria in advanced search options are:

• Email - Equals, Is Empty

• First Name - Contains Keywords, Contains Phrase, Is Empty

• Identifiers - Equals

• Job Category - Equals, Is Empty, Not Equals, Is Not Empty - equals and not equals options display a multiple choice
drop-down list.

• Last Name - Contains Keywords, Contains Phrase, Is Empty

• Middle Name - Contains Keywords, Contains Phrase, Is Empty

• Primary Identifier - Equals

This feature is not deployed in the sandboxes and will be available only on production environments.

See Searching in Alma.

XSL Transformation as Part of an Integration Profile
July 2020 Administration and Infrastructure
Now when importing users to Alma from SIS systems that use other data formats than Alma, you can convert data format
from the source system formats to the format required by Alma. Previously, the conversion had to be done outside of Alma,
and demanded specific technical knowledge and resources from institutions.

To facilitate the conversion process, you can now do the following:

• Define an XSLT converter to be used by Alma
• Apply the XSLT converter to an Integration Profile that defines the way data is imported into Alma
• Manage XSLT converters in Alma:

◦ Share converters between institutions
◦ Preview results on a demo file
◦ Validate converters

Currently, this is possible for the following integration (see Student Information Systems):

• SIS import
• SIS synchronization

The ability to define XSLT converters is disabled by default. If your institution would like to activate this behavior, please
contact Ex Libris customer support.
To manage XSLT converters, a new page Integration XSL Converters was introduced (available from Configuration >
General). This page allows creating and editing EXSL converters, as well as allows institutions to share converters in the
Community Zone.
See Integration XSL Converters.
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Notification on Last Community Zone Update
July 2020 Administration and Infrastructure
A notification about the date of the most recent Community Zone update was added to the Help menu located in the Main
Menu Icons.

Institutions that work with the Community Zone expect that Community Zone resources will be up-to-date to the most recent
Community Zone update. To this effect, the Synchronize Changes from CZ job runs daily in each institution updating
authorities and resources from the Community Zone to the local institution.

However, if the number of updates in the Community Zone is very large, the job cannot complete on the same day. Every
day the job attempts to close the gap. Thus, in cases of very large Community Zone updates, a delay of a few days might
occur in the synchronization of CZ and the local institution. However, when customers do not see the relevant resources
updated in their institutions on the day of the Community Zone update, or on the next day, the discrepancy might cause
alarm.

The new notification in the Help menu lets you know the date of the last Community Zone update that was implemented in
your system. If the date indicated is not today's date, the reason you do not see some Community Zone updates in your
system is due to this delay. You need to wait for the following runs of the job to update your resources.

See Synchronize Changes from CZ and The Alma User Interface.

New Alma Layout Enabled
July 2020 Administration and Infrastructure
Continuing the rollout of the new Alma layout, starting from the July release, the new layout will be available for Alma users
in the sandbox. For a full list of changes, see Layout Improvements.

In July-deployed environments where the Community Zone Harvesting job has not run yet this notification is not
displayed. It will be displayed once the Synchronize Changes from Community Zone job has run.

Note
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Alma Administrators can turn the new functionality on for a specific user (Opt-in). Ex Libris will introduce the new layout
gradually over several Alma releases (See Rollout Plan), giving users enough time to understand, experience, and get used
to the changes. As part of the rollout plan, we encourage as many users as possible to get themselves familiarized with the
new layout. For instructions for the Alma Administrator, see Turning On the New Layout for Users.

The new layout increases your working area, improves navigation, gives you more options to customize your menus, and
facilitates improved user workflows. For a full list of changes, see Layout Improvements.

Creation of Several Itemized Sets From File in Parallel
July 2020 Administration and Infrastructure
When creating itemized sets, one of the options to add records to a set is uploading a file that contains the identifiers (MMS
ID, ISSN, ISBN, and so forth). The Add Members to Set job runs and creates a set from the file. Previously, only one
instance of the job could be run simultaneously. Now any number of instances of this job can run in parallel.

See Creating Itemized Sets.

Skipped Job Status
July 2020 Administration and Infrastructure
The status of jobs that need to be skipped was changed to 'Skipped'. Previously, the status of these jobs was indicated as
'Failed', which was misleading.

Alma skips jobs in the below cases:

• Another instance of the job is currently running, and the job does not allow multiple instances.

• The job is dependent on the completion of another job, and that job is still running.

See Viewing Running Jobs.

Dependent Job Waiting
July 2020 Administration and Infrastructure
The below dependent jobs now wait till the completion of the job they are depended on with the status 'Pending', and start

Ex Libris recommends that all users gain experience with the new Alma layout prior to the new layout Go-Live, which is
planned to take place with the deployment of the September 2020 release.

Note
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running after that job completion:

• Authorities - Link BIB Headings
• Authorities - Preferred Term Correction
• Authorities - Handle Local Authority Record Updates
• MMS - Build Record Relations

Previously these jobs were skipped with the status 'Failed', which was misleading.
See Overview of Jobs.

External Users with Internal Authentication
July 2020 Administration and Infrastructure
For institutions whose Student Information System (SIS) does not offer authentication services, it is now possible to create
users as external in Alma, but assign passwords for them directly in Alma. In this case, all the user information, such as
name, ID, etc, is managed from the SIS, but the passwords are stored in Alma and managed by the Ex Libris Identity
Service.

When this behavior is active, changing a user from external to internal (and vice versa) does not reset the user password;
the existing password the user used as an external user is retained.

This new behavior is activated by a customer parameter, upon request. If your institution's SIS does not offer authentication
services and would like to activate this behavior, please contact Ex Libris customer support.

See Registering Patrons and Mapping User Accounts to Other Systems.

Support Sending SHA-256 Logout Requests
July 2020 Administration and Infrastructure
Previously, SAML logout requests were always signed with SHA1 (also called SHA128) signature. Now the default
for logout requests is to be signed with SHA2 (also called SHA256).

New profiles are now signed with SHA2, but this can be changed to SHA1, if needed.

Existing profiles continue to be signed with the SHA1 signature, but this can be changed to SHA2, if needed.

See SAML-Based Single Sign-On/Sign-Off.
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Request Anonymization and Anonymization Rules
July 2020 Fulfillment

Idea Exchange
You can now define rules for all anonymization types, not just loans. The anonymization job, which runs once daily, is
Fulfillment - Handle Historical Archiving. The rules are found in the Fulfillment Jobs Configuration page (Configuration
Menu > Fulfillment > General > Fulfillment Jobs Configuration) next to each anonymization type. This is now the only
place the anonymization rules are accessed. The link to Loan Anonymization Rules is no longer available on the Fulfillment
Configuration menu.

The customer parameter, should_anonymize_requests, which previously anonymized a request as soon as it was
completed, has been renamed to should_anonymize_requests_immediately_when_complete. Now, when set to true,
Alma still anonymizes the request as soon as it is completed and also ignores the anonymization rules.

When creating a rule for request anonymization, if choosing Library or Location as input parameters, the library and
location are calculated as follows:

When a request is completed, if there are multiple items available, if the request was attached to a specific item, for
instance, item level request or item already fulfilled the request, the library and location of the item is used. If the request
can still be fulfilled by multiple items, the library and location are taken from the holding selected automatically as preferred
for fulfilling the request.

As previously, checking requests anonymize both borrowing and lending requests. However, rules can be applied only to
borrowing requests.

See Configuring Anonymization.

Watch the Request Anonymization and Anonymization Rules video (4:28 minutes).

Option to Exclude the Grace Period When Calculating Fee
July 2020 Fulfillment

Idea Exchange
Previously, when calculating fees, when the grace period ended, fines were immediately implemented and set for the entire
period including the grace period. Now, the grace period can be set to not be included in the fine period at all. In the policy,
currently, you can now configure new periods. Each of the prior periods now has a second period with excluded from day.
When that period is selected, the fee calculations are the same, but they are based on the end time of the grace period
instead of the due date.

See Physical Fulfillment.

Watch the Exclude the Grace Period when Calculating a Fine video (1:23 minutes).

Digitization Request File Upload Limit
July 2020 Fulfillment
For attachment digitization requests, the file size limit was increased from 10 MB to 25 MB.

See Digitization Processing.
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ISO 18626 - Return Information
July 2020 Fulfillment - Resource Sharing
When using the ISO 18626 resource sharing partner type, return information is now supported. The lending partner can
select Send ReturnInfo on the Resource Sharing Partner page to include the information for the originating lending library
instead of the resource sharing library. The ISIL code of the lending library is then included in the resource sharing request,
if it is populated. The ISIL code is presented on the Resource Sharing Borrowing Task List as Return Information. It is
also available in the XML for the ResourceSharingReturnSlipLetter. The field appears in the letter when populated. If the
letter is customized, you must manually add the field to the XML in order for it to be populated.

When scanning an item through the Scan In Interface, the destination information is added to each line. When returning
through Returns, it is added to the pop-up display.

Check-In for Shipped Items in the Scan In Interface
July 2020 Fulfillment - Resource Sharing

Idea Exchange
You can now set a message to warn the users if they are going to complete a lending process when scanning items. On the
Scan In Messages Configuration page, the Complete lending request message, which defaults to none (no message),
can be set to Popup message. When this is set, if an item is scanned in and is part of a Resource Sharing Request that
is linked to a lending request in status Shipped Physically, the warning message will require a Confirm or Cancel action.
This way the user cannot accidentally complete the lending request. If the message is set to Feedback message, rather
than Popup, the feedback will tell them that the request will be completed, but the scan in action cannot be canceled.

See Scanning Items.

Export Renew Allowed Indication in API to ILLiad
July 2020 Fulfillment - Resource Sharing
The ILLiad API now supports sending the Renewals Allowed field in a resource sharing request. The 'RenewalsAllowed'
indication will be set according to the lending workflow profile that is attached to the ILLiad partner. If one of the following is
enabled then Alma will send "RenewalsAllowed": true

• Patron renewal

• Staff renewal

If both patron and staff renewal are disabled then Alma will send "RenewalsAllowed": false.

Distribute Users from the Network Zone
July 2020 Collaborative Networks
Networks that share their user list in the Network Zone can create and update the network zone users manually using the
Alma Manage Users menu, the API or the Update/Notify Users job. This is in addition to the previously only option to
manage the Network Zone users using SIS feeds.

Users can now be updated in the Network Zone in the following ways, and the changes will be reflected in the Institutions
that have a copy of the user record:
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• The update/notify users job

• Using an API

• Manually updating the user in the User Edit form

See Centrally Managing Users in a Network Zone.

Order Indication for Electronic Resources Ordered from NZ
July 2020 Collaborative Networks
In a Collaborative Network where electronic resources are managed centrally in the Network Zone and the orders are
managed in the individual Institution Zones, institutions can order electronic collections or portfolios managed in the NZ.

In such cases, when using the staff search for electronic portfolio and electronic collection for Network Zone resources
(both combined and NZ searches), Alma will now display the order icon by the records ordered from the Network Zone.
Clicking on the link of the number of orders displays the list of the PO Lines of these orders.

Saving Local Sets in Network Zone
July 2020 Collaborative Networks

Idea Exchange

In Network search

In combined search
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Now the Institution Zone staff can create a local set of bibliographic records in the Institution Zone and then save the set in
the Network Zone.

This is useful in use cases where a set can only be built in the Institution Zone because the query uses search criteria from
either localized fields in the bibliographic record or from the inventory (holdings, items, portfolio, etc.) However,
you cannot run normalization rules on Network Zone bibliographic records from within the Institution Zone, since non-
localized fields in the Network Zone bib records cannot be changed from within an Institution Zone.

The current development allows the Institution Zone staff to save a local set of bibliographic records to the Network Zone,
where they can then perform any actions with the set, such as running normalization on the bib records.

To support this functionality, the Save in Network action was added to the Manage Sets page (Admin > Manage Jobs and
Sets > Manage Sets). Choosing this action saves a local set of bibliographic records to the Network Zone. See Saving Sets
in Network Zone.

The new action runs a job that creates a set in the NZ containing only the records linked to the Network out of all
records. See Save Set in Network Report.

Sharing and Contributing General Electronic Services in the Community Zone
July 2020 Collaborative Networks
Users now can contribute their General Electronic Services to the Community Zone, where other institutions can copy and
use these services.

See Sharing General Electronic Services in the Community Zone and Community Zone Contribution Guidelines.

Improvements to Electronic Collections Contributions
July 2020 Collaborative Networks
Electronic collection contribution was enhanced as follows:

• Now you can contribute to additional fields, including static and dynamic URLs.

• Now you can update additional fields of your contributed electronic collections and share your updates with the
community.

Additional Electronic Collection Fields that You Can Contribute

The following additional fields can now be contributed:

The current functionality of distributing general electronic services from Network Zone to Institution Zone using the
Distribute Fulfillment Network Configuration job remains as is (see Configuring Fulfillment Information in the Network
Zone).

Note

The ability to share general electronic services in the Community Zone will become available a few days after the July
installation.

Note
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Collection Service Portfolio

• Type

• Interface name

• Level URL

• Is Free?

• Description

• Language

• Category

• URL type: Dynamic URL

• Linking level

• Service is free?

• Crossref supported

URL type:

• Static URL

• Dynamic URL

See Managing Electronic Collections.

Updating Your Contributed Electronic Collections

If you are the contributor to the electronic collection, now you can update additional fields and share these updates with the
Community Zone. Your changes are submitted to a job that runs overnight to update the electronic collection, its portfolios,
services, and bibliographic records in the Community Zone. This job copies the information from the override fields to the
main fields and then removes the override values. This synchronizes your electronic collection with the Community Zone.

To update an electronic collection in the Community Zone:

1. In the Institution tab of the electronic collection, enter the new values in the override fields, and select Update in
Community.
This updates the Community Zone with the new values.

2. In the confirmation message that appears, click Yes.

See Updating Community Zone Contributed Electronic Collections.
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Contributing Static and Dynamic URLs

Now Alma supports the contribution of portfolio Static/Dynamic URL and service Dynamic URL, in addition to the existing
contribution of parser parameter URL. This way, you see in the Community Zone the exact URL that you contributed.

Override Fields of Community Zone Electronic Collections

All activated Electronic Community Zone Electronic collections are edited with your own information. Your edits are only
local, no changes are made to the Community Zone record.

When editing the collection, you make your edits in the override fields. Any later updates to this electronic collection will
update only the main values so that you know what the updates were. Your local override values remain unchanged.

The following additional fields can now be edited:

Collection Service Portfolio

• Type (override)

• Interface name (override)

• Level URL (override)

• Is Free? (override)

• Description (override)

• Language (override)

• Category (override)

• URL type: Dynamic URL

• Linking level (override)

• Service is free? (override)

• Crossref supported (override)

URL type:

• Static URL (override)

• Dynamic URL (override)

See Managing Electronic Collections.

Audio Visual Media type Added to the Physical Material Type Description Table
July 2020 Resource Management
The Physical Material Type Description table now includes an Audio visual media option.

See Configuring Physical Item Material Type Descriptions.

Additional Elements in Related Record for Physical Inventory
July 2020 Resource Management
For a child record, Alma now supports displaying a specific item when cataloging a specific issue, part or pages. Previously,
Alma supported displaying specific items of the parent record only when cataloging a specific year, volume or barcode.
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The following item specifications are now supported:

Item Specifications Value in
$g (MARC21 / KORMARC) $v (Unimarc / CNMARC) Item Field

Issue iss: Enum B

Part pt: Enum C

Pages p: pages

MARC 21 example:

For the below record, two related holdings are shown:

The link in the child record is cataloged in field 773, including the new label iss: (issue):

After the filtering, only the holdings with the specific item pointed is shown:

UNIMARC example:

The parent record with many items in different years, volumes and issues:
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The link in the child record is cataloged as follows, including the new label iss: (issue):

The child record shows in the repository search only the holdings referred to by this field:

See Configuring Related Records for Physical Inventory.

MARC 21 Updates
July 2020 Resource Management
The following MARC 21 updates (for bibliographic, authority, holdings, classification, and community information formats)
have been added to Alma in the July 2020 release:

• MARC21 BIB

◦ Update No. 27 (November 2018)

◦ Update No. 28 (May 2019)

• MARC21 Holdings

◦ Update No. 28 (May 2019)

• MARC21 Authority

◦ Update No. 26, April 2018

◦ Update No. 28, May 2019

Refer to http://www.loc.gov/marc/status.html for additional details regarding these MARC 21 changes.

Reload Bibliographic Records from Central Catalog On Demand
July 2020 Resource Management
Users working on Bibliographic records in Central Cataloging (Aleph, SBN, CALIS, etc.) need to ensure that they view and
update the most recent version of a Bibliographic record.
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A new option Reload Record from Central Catalog was added to the Metadata Editor under the File menu. This option
enables reloading the most recent version of the Bib record that was loaded previously from the Central Catalog. This
restores the Bib entire record from the Central Catalog, removing any changes made by you.

This action is available for Bibliographic records that are managed centrally with the required prefix in 035, and the ones
that are managed locally. However, only records managed centrally are reloaded.

See MD Editor Menu and Toolbar Options.

Align Record Version with SBN
July 2020 Resource Management
Now users working in SBN can align the local record version with the SBN record version, without making any additional
changes to the local version. Since now the date is the same, SBN accepts the record contribution.

A new entry Align Record Version with Central Catalog was added to the Metadata Editor (Tools > MARC
Bibliographic). Selecting this option updates the local version of the record with the SBN record version.

The Reload Record from Central Catalog option is available only when both below criteria are met:

• if you have configured a Central Catalog integration profile,

• when working on Bibliographic records.

Note
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See Integrating the SBN Italian Union Catalogue and MD Editor Menu and Toolbar Options.

Public Access Model on the Portfolio Editor
July 2020 Resource Management
Access Model defines how end-users can access the electronic resources. The access model has always been indicated in
the PO line, but now it is also displayed in a new field Public access model that was added to the Acquisition tab of the
portfolio editor. This field presets the active access model associated with the portfolio, as inherited from the PO line that
created the portfolio. Any updates to the access model on the PO line are reflected in the Public access model field of the
portfolio editor. See Editing a Portfolio Using the Electronic Portfolio Editor.

You can also change the value of the Public access model field directly on the portfolio editor, and this determines the
active access model of the portfolio. However, changing the access model value on the portfolio does not update the
access model on the PO line.

The option is visible only if a central catalog integration profile for SBN is defined.

Note

In case a PO line of type 'License Upgrade' was added to the portfolio as an additional PO line, the Public Access
Model field on the portfolio displays the access model associated with the license-upgrade order.

Note
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The Include access model in portfolio public note checkbox, which previously controlled the presentation of the access
model on the portfolio's Public Note field in the Alma Link Resolver, was now removed from the New Order API integration
profile. See Real-Time Ordering.

To control the presentation of the access model to patrons via Alma Link Resolver, institutions now can use a designated
configuration located under Fulfillment > Discovery Interface Display Logic > Other settings. Select the checkbox
Enable Display of Access Model to display in Primo the access model information located on the portfolio.

The new Enable Display of Access Model option is disabled by default. Institutions that previously had the Include
access model in portfolio public note check box enabled in their integration profile, will need to select the Enable
Display of Access Model option in the new configuration screen. See Configuring Other Settings.

Manage Selected Physical Items
July 2020 Resource Management
Following the changes made in June 2020 release, the actions that previously were displayed as links of the page actions,
were now added to the Physical Items list, to enable you to perform actions on multiple physical items in bulk. In addition,
when you select items from the list, the item counter above the list now provides an indication of the number of items
selected.

"Public access model" field on the portfolio editor

Primo VE will support this configuration in a future release.

Note

Due to changes required in the definition of columns, the default display will be restored as part of July release
deployment. If display customization was applied, it will need to be redone.

Note
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Some of the actions that can be performed, such as running a job and creating/adding to the itemized set, can only be
performed if you possess the required permissions.

See Working with the List of Items.

Watch the Manage Selected Physical Items video (0:51 minutes).

Improvements to Electronic Collection and Portfolio Deletion
July 2020 Resource Management
The process of electronic collection and portfolio deletion was made more user-friendly. Now the options to edit records
(add, edit or delete) are disabled on electronic collections, portfolios and services once these resources are marked for
deletion. In addition, now you are blocked from attaching a stand-alone portfolio to a collection that is marked for deletion
(unless the portfolio has some available services).

Using Community Zone Electronic Collections in Import Profiles
July 2020 Resource Management

Now Import Profiles can work with electronic collections activated from the Community Zone. This means that when
importing to an CZ collection, and local portfolios do not exist, the CZ portfolios are imported.

For that purpose, a new checkbox "Use Community Zone portfolios" was added to the Inventory Information tab of the
Import Profile Details page (Resources > Import > Manage Import Profiles or Acquisitions > Import > Manage Import
Profiles). When selected, then upon import, Alma now attempts to match each bibliographic record against the
bibliographic records that have portfolios that are part of the collection activated from CZ.

• If a matching bibliographic record is found, Alma imports the relevant portfolio.

• If a matching bibliographic record is not found - Alma creates a local portfolio that is associated to the CZ collection.

• If multiple bibliographic records are found as a match in the CZ under the specific collection – no import takes place.
The record is reported in the "Resolve import issues" list.

◦ Note that Alma does not activate this portfolio. You can activate this portfolio at any time. To activate upon
import, click the "Activate resource" checkbox at the bottom of the Inventory Information tab.

◦ If a matching bibliographic record is found, its information is taken from the Community Zone. The information
filled in the fields below ("Extract portfolio information from field", "Extract access URL from field", "Extract
interface name from field", "Extract internal description note from field", "Extract authentication note from
field", "Extract public note from field", "Extract library from field") are ignored.

Note
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The "Use Community Zone portfolios" checkbox appears only when both the below conditions are true:

• The selected inventory operations are Electronic or Mixed.

• Portfolio type is Part of Electronic Collection.

See Managing Import Profiles.

Enhancements to Forms
July 2020 Digital Resource Management
Several enhancements have been added to the Alma Forms feature (Configuration > Resources > Metadata
Configuration > MARC21 Bibliographic or Qualified Dublin Core > Forms tab) when selecting Add fields:

• The Checkbox field type was added.

• The Repeatable field was added to the field types (when configured) to allow the user to add multiple instances of the
field. This is available only for Patron Deposit forms.

• For date fields, if configured to be mandatory, the Default Value field is set to the current date.

Enhanced Sorting Support for Collections
July 2020 Digital Resource Management

Idea Exchange
You can now configure the default sorting for titles and sub-collections in Primo VE, using a richer set of title-level sort
routines.

• To configure the default sorting of titles in a collection, select an option from the Sort titles by drop-down list
(Resources > Manage Collections > Edit Collection > Discovery Tab):
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• To configure the default sorting of sub-collections in a collection, select an option from the Sort by drop-down list
(Resources > Manage Collections > Edit Collection > Sub-collections tab):

DARA Recommendation to Identify Missing Items
July 2020 DARA
DARA now identifies items that have been missing for a significant amount of time and recommends that you handle them.

By default, DARA identifies items missing for more than 12 months. You can customize DARA to produce
recommendations that better suit the needs of your institution. For more information, see DARA – Data Analysis
Recommendation Assistant.

Sort Titles By

Sort By

Missing Items
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